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2 Disclaimer 

The actual version of this product (document) is available as is. TEC-IT declines all warranties 
which go beyond applicable rights. The licensee (or reader) bears all risks that might take place 
during the use of the system (the documentation). TEC-IT and its contractual partners cannot be 
penalized for direct and indirect damages or losses (this includes non-restrictive, damages through 
loss of revenues, constriction in the exercise of business, loss of business information or any kind of 
commercial loss), which is caused by use or inability to use the product (documentation), although 
the possibility of such damage was pointed out by TEC-IT.  

 

 
We reserve all rights to this document and the information contained therein. Reproduction, 
use or disclosure to third parties without express authority is strictly forbidden. 
 

 
Für dieses Dokument und den darin dargestellten Gegenstand behalten wir uns alle Rechte 
vor. Vervielfältigung, Bekanntgabe an Dritte oder Verwendung außerhalb des vereinbarten 
Zweckes sind nicht gestattet. 
 

© 1998-2010  
TEC-IT Datenverarbeitung GmbH  
Wagnerstr. 6 

A-4400 Austria  
t.: +43 (0)7252 72720  
f.: +43 (0)7252 72720 77  
http://www.tec-it.com 

 

http://www.tec-it.com/
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3 Introduction 

3.1 About 

TEC-IT Barcode Studio is a tool for generating and printing bar codes.  

Barcode Studio creates more than 100 different barcode symbologies: linear, 2D, postal and GS1 
composite bar codes are supported. All bar code parameters are adjustable. The bar codes are 
created as image file (e.g. for using it in your artwork), as high quality vector image (for graphics 
design or pre-press applications), copied to the clipboard or printed directly with any printer. Batch 
barcode generation with external or manual entered data is also supported. 

If you have any questions, please contact us. 

Address: Wagnerstr. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: office@tec-it.com 

Web: http://www.tec-it.com 

3.2 Supported Operating Systems 

 Mac OS (10.4 or higher) for Intel 

 Mac OS (10.4 or higher) for PowerPC 

 Windows 7 

 Windows Vista 

 Windows XP 

 Windows Server 2003 

 Windows Server 2008 

 Linux/UNIX (please refer to www.tec-it.com or request a build) 

3.3 Restrictions of the Demo Version 

► A demo marker across the bar code indicates that the demo version is active. The 
correctness of the bar code is not affected. 

► To obtain a license key for the full version (without the demo marker) please order Barcode 
Studio online at http://www.tec-it.com/order/default.aspx. 

 

mailto:office@tec-it.com
http://www.tec-it.com/
http://www.tec-it.com/
http://www.tec-it.com/order/default.aspx
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4 Installation 

4.1 Install Barcode Studio on Microsoft® Windows 

On Microsoft
®
 Windows operating systems (XP, Vista, etc.), Barcode Studio is installed with the 

Windows Installer. If the Windows Installer is not available on the system, please download it from 
following link: 

 http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-
de776fd4138c&displaylang=en 

The following steps need to be performed (you need to have administrator privileges). 

1. Open the installer by double-clicking it. 

2. Follow the instructions of the installation wizard. 

By default, Barcode Studio is installed in the following directories: 

C:\Program Files\TEC-IT\BCStudio10  (binary files + documentation) 

C:\ProgramData\TEC-IT\BCStudio\10.0 (templates, option file, etc.) 

4.2 Install Barcode Studio on Mac OS X® (10.4 or higher) 

For Mac operating systems (Mac OS X 10.4 or higher), Barcode Studio is provided as a dmg-file. 

The following steps need to be performed (you need to have administrator privileges). 

1. Open the dmg-file by double-clicking it. 

2. Drag the program icon onto the application path. 

http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
http://www.microsoft.com/downloads/details.aspx?FamilyID=889482fc-5f56-4a38-b838-de776fd4138c&displaylang=en
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5 Quick-Start 

5.1 Introduction 

This chapter will guide you through the most important functions of Barcode Studio by showing 
you how to create an EAN13 bar code. For more detailed explanation of the user interface and the 
available functions and settings, please refer to the chapters 6 and 7. 

► Starting with Barcode Studio version 10 pre-defined barcode templates are available. The 

creation of standardized bar codes is simplified dramatically (see section 5.3).  

5.2 How to Create an EAN13 Bar Code 

 
Figure 1: Quick-Start – Barcode Studio Main Window 

In order to create an EAN13 bar code, please perform the following steps: 

Select the bar code type (symbology) – see section 5.2.1. 

Enter the bar code data - see section 5.2.2. 

Select the output resolution - see section 5.2.3. 

 Specify the bar code dimensions - see section 5.2.4. 

 Fine-tune the module width - see section 5.2.5. 

 Set font style and size - see section 5.2.6. 

 Export or print the bar code. 
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5.2.1 Select Bar Code Type (Symbology) 

  
 

Select the bar code type (symbology) in . Choose 
“EAN 13” from the list of symbologies. 

Hint: If you press the E key, the first entry starting 
with an “E” will be selected. 

 

5.2.2 Enter Bar Code Data 

A valid EAN13 barcode needs exactly 12 digits (or 13 digits including the check digit). By default 
you will see valid data (“123456789012”) if the checkbox “Example Data” is checked. 

 

 
 

Enter the data to be encoded in . You can also 
edit the bar code content in the Bar Code Data 
dialog or import it from a file (see 7.7.1.1). 

  

 

The bar code view is updated after every change. If 
you enter exactly twelve (or thirteen) characters, 
the bar code will be drawn in the bar code view in 
the top left corner. 

If “Example Data” is not checked, it is possible that the input data is invalid (e.g. wrong characters 
or a wrong number of characters). In this case you will see an error message like following instead 
of the bar code: 

Error: Wrong number of input characters (12 chars needed)! 

For a list of the most common error messages, please refer to Appendix B. 

► The 13
th
 digit in the resulting EAN13 bar code (in this case the digit “3”) is the check digit. It 

will be calculated automatically. 

► If you enter 13 (instead of 12) characters you need to provide the correct check digit by 
yourself. This is not recommended (unless you supply the correct value). A wrong check 
digit may make the bar code unreadable! 
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5.2.3 Select Output Resolution 

► Barcode Studio uses the selected resolution for computing the barcode images. Thus it is 
essential to adjust a resolution which leads to readable bar codes (see also section 5.2.5).   

► Usually higher resolutions lead to better bar code quality. Please notice that it is very 
important that the selected resolution accords to the resolution of the output device (printer, 
image or of image processing / layout software). 

 

The output resolution can be adjusted in .  

 

In this example the output resolution is changed to “300 
dpi”. If you are planning to print the bar code on a laser 
printer you would most probably select a higher resolution 
(600 or 1200 dpi). 

If you want to export the bar code as image for your web 
page you could also choose “Screen Resolution” or “72 dpi 
(BMP)”.  

 

► If you use bar code images in pre-press applications, take care to avoid any scaling or 
resizing of the generated bar code image. This may lead to inaccuracies and distortions 
rendering the bar code unusable. Generate the bar code image in exactly the resolution and 
size as required! 

5.2.4 Specify Bar Code Dimensions 

The bar code dimensions can be modified by changing width, height, and module width. 

Most label or bar code specifications require specific bar code dimensions. Following values are 
usual for EAN13: 

Magnification 
factor 

Module width [mm] Width [mm] Height [mm] 

0.80 0.264 (SC0) 29.83 20.73 

1.00 0.330 (SC2) 37.29 25.91 

1.50 0.495 (SC6) 55.94 38.87 

2.00 0.660 (SC9) 74.58 51.82 

Table 1: EAN13 Dimensions (not complete) 

 
 

Here we use the magnification factor 1.00. 

 

Enter the width and the height in . The appropriate module 
width will be calculated automatically. 

 

 

The bar code looks now like this. 
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5.2.5 Fine-tune the Module Width 

Yet the quality of the bar code is not perfect (see the Quality Watch at the top right corner of the 
Barcode Studio‟s application window): 

 

To optimize the bar code quality we recommend you to fine-tune the module width. You have the 
following options: 

 Select the option “Optimal Size” (see Figure 1, ) 

 Choose “Pixel” in field “Unit” and enter a whole-numbered value in the field “Module Width”. 

 Increase the output resolution 

The first two options both lead to a “perfect” bar code quality. 

5.2.6 Set Font Style and Size 

The font properties can be set via the “Select Font” dialog. You can open this dialog by clicking the 

 button in the “Text Placement” section (see Figure 1 ). 

This example uses a 10 pt Courier New font: 
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5.3 Barcode Templates 

The list of barcode templates contains a selection of frequently used barcode types including their 
default settings.  

► The templates which are part of the Barcode Studio installation comply with various bar 
coding standards. You save time by creating optimal bar codes and efforts for an optional 
certification of your bar code artwork are minimized. 

In order to create an EAN 13 barcode with default sizes using a template you have to perform 
following steps: 

Go to the templates list. 

Select the entry EAN 13 / SC2 (100%)… 

Enter the bar code data - see section 5.2.2. 

 Adjust any other settings if needed. 

 Export or print the bar code. 

 

 
Figure 2: Quick-Start with Templates – Barcode Studio Main Window 

 












 
 
 

Page 13 of 58 

 

Barcode Studio User Manual  

6 Using Bar Codes in Applications  
(Exporting Bar Codes) 

This chapter is a general instruction for using bar codes generated with Barcode Studio in other 
applications. A detailed explanation of the user interface and available bar code settings can be 
found in the next chapter. 

6.1 General 

You can export the bar codes created in Barcode Studio in the following ways: 

 Copy the bar code to the clipboard (as image) and paste it into your application. 

 Copy the bar code to the clipboard (as metafile) and paste it into your application. 
(available under Microsoft Windows only) 

 Export the bar code to an image file. 

 Export a series of bar code images (batch job). 

Before the export of a bar code you have to adjust the required bar code settings. The size of the 
resulting bar code image can be controlled by changing the dimensions (width, height, and module 
width) and the output resolution (DPI) – see also section 7.7.2 . These settings apply to all kinds of 
export operations.  

6.2 Resolution and Readability 

► Do not resize exported bar code images with image manipulation software (like 
Photoshop

®
)! The quality and the readability might suffer! 

► Whenever possible, let Barcode Studio create the bar code in the required size and 

resolution to avoid resizing later on. 

6.2.1.1 Bar Code Quality 

When exporting the bar code to a bitmap image (BMP, GIF, JPG, PNG, and TIF), it must be 
converted from its internal resolution (high) to a graphical pixel resolution (low). During this process 
(rasterizing) the module width can vary due to rounding errors. 

When exporting a bar code to a vector based image format (EPS, E4C, and E1C) or as metafile to 
the clipboard, the internal representation of the bar code symbol allows a very high resolution 
(which is independent of the adjusted dpi). Thus it is recommended to use vector based image 
formats (EPS, E4C and E1C) whenever possible. However, in the context of certain applications 
(e.g. web applications) it is inevitable to use bitmap images. 

The readability of a bar code can be estimated by considering the quality watch (see section 7.1, 
). The quality of a bar code depends on the selected output resolution, the bar code‟s size and its 
content. To ensure an optimal readability, check the option “Optimal Size”. 

6.2.1.2 Module Width 

Larger module widths usually lead to a better readability of a bar code. In practice, for most linear 
bar codes, the module width should never be less than approximately 0.2 mm.  
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6.3 Export to File 

If you want to export a bar code as an image file, select Export ► Export Barcode… from the menu 
or press the keyboard shortcut Ctrl+E. In the Save Image File dialog choose a filename, select the 
image file type (e.g. “Bitmap (*.bmp)”), and confirm by pressing the Save button. 

The saved image can be imported in your target application (e.g. Microsoft
®
 Word). To import the 

image in Microsoft
® 

Word you would select Insert ► Image ► From File… from the menu. 

► The exported bar code symbol will match the preview in Barcode Studio exactly. 

► To see a list of available image formats, please refer to Appendix C. 

► If the format of the resulting image is a bitmap based file format (see Appendix C), resizing 
of the imported image is not recommended! 

6.4 Copy to Clipboard (As Image) 

To copy the current bar code as an image to the clipboard, you have to select Copy to Clipboard 
(As Image) from the menu (located in the Image submenu) or from the toolbar. You can also press 
the keyboard shortcut Ctrl+B. 

Then switch to your target application and paste the bar code (e.g. in Microsoft
®
 Word) by pressing 

Ctrl-V (or by selecting Edit ► Insert from the menu). 

► Resizing bar code images may result in a loss of quality, in the worst case in unreadable bar 
codes.  

6.5 Copy to Clipboard (As Metafile) 

To copy the current bar code as vector based metafile (EMF) to the clipboard select Copy to 
Clipboard (As Metafile) from the menu (located in the Image submenu) or from the toolbar. You can 
also press the keyboard shortcut Ctrl+M. 

Then switch to your target application and paste the bar code (e.g. in Microsoft
®
 Word) by pressing 

Ctrl-V (or by selecting Edit ► Insert from the menu). 

► Metafiles can only be used on Microsoft
®
 Windows. 

► Due to the vector based format you may resize the imported image within your target 
application without heavy losses in readability. 

► The resulting bar codes may differ from the preview in Barcode Studio. The bars in the 
symbol may be enlarged and therefore the font of the human readable text may not fit 
exactly. 

6.6 Export Data List 

Lists of bar codes can be imported, generated, edited, and at last exported to image files. See 
chapter 8 Data List. 
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7 Barcode Studio User Interface 

7.1 Main Window and Menu 

 

 
Figure 3: User Interface 

The main window is split into the following areas: 

 Menu (see section 7.2) 

 Toolbar (see section 7.3) 

 Barcode View (see section 7.6) 

 Quality Watch (see section 7.4) 

 Bar Code Settings (see chapter 7) 

 2D Settings (available only for certain Barcode Symbologies) 

 Barcode Types and Templates (see section 7.5) 
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7.2 Menu 

The menu gives you access to the following functions: 

7.2.1 File 

New Create a new document (with initial bar code settings). 

Shortcut: Ctrl+N 

Open… Open an existing bar code settings document file (*.bc). 

Shortcut: Ctrl+O 

Save as… 

Save 

Save the current bar code settings document file (symbology, dimensions, module width, 
etc.). Bar code settings files have the extension .bc. 

Shortcut: Ctrl+S (for Save) 

Save As Template… Save the current bar code settings as template file. 

Refresh Templates Refresh the template list. 

Shortcut: Ctrl+R 

Print… Print the document with current bar code settings.  

The output resolution, and so the values for quality and deviation, depend on the printer 
settings.  

Note: Inkjet printers sometimes produce better results if bar width reduction is set (see also 
section 7.8.1.4). 

Shortcut: Ctrl+P 

Page Setup… Choose the paper size, the paper source, the orientation, and the page margins. 

Exit Exit Barcode Studio. If you have unsaved changes, Barcode Studio will prompt you to 
save before exiting.  

Shortcut: Ctrl+Q 

7.2.2 Image 

Export Barcode… Export the bar code to a picture file. 

Shortcut: Ctrl+E 

Copy to Clipboard (As 
Image) 

Copy the bar code as image to the clipboard. 

Shortcut: Ctrl+B 

Copy to Clipboard (As 
Metafile) 

Copy the bar code as metafile to the clipboard (Windows only). 

Shortcut: Ctrl+M 

7.2.3 Data List 

File Import… Import data from a text file and add it to the data list. 

Shortcut: Ctrl+I 

Create Sequence… Create a data sequence and add it to the data list. 

7.2.4 Export 

Export Data List… Export the data list as a series of bar code images. 

Shortcut: Ctrl+L 

7.2.5 Tools 

Options… Specify the Application‟s Options (see Chapter 9). 

7.2.6 Help 

Help Open the documentation. 

Shortcut: F1 

Barcode Reference Open the default browser and navigate to the bar code reference document. 

License... Enter your license data. 

Check For Update… Check for updates of Barcode Studio. 
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TEC-IT Website Open the default browser and navigate to www.tec-it.com. 

Buy Barcode Studio Open the default browser and navigate to the order form. 

About Barcode Studio Displays the application information, version number and copyright. 

7.3 Toolbar 

 
Figure 4: Toolbar 

The toolbars offer following functions: 

 
New Create a new document (with initial bar code settings). Shortcut: Ctrl+N 

 
Open Open an existing bar code settings file (*.BCS). Shortcut: Ctrl+O 

 
Save Save the current bar code settings to your hard disk. Shortcut: Ctrl+S 

 
Print Print the current bar code. Shortcut: Ctrl+P 

 
Export Barcode Export the bar code to a picture file. Shortcut: Ctrl+E 

 
Copy to Clipboard (As Image) Copy the bar code as image to the clipboard. Shortcut: Ctrl+B 

 
Copy to Clipboard (As Metafile) Copy the bar code as metafile to the clipboard. Shortcut: Ctrl+M 

 
Export Data List Export the data list as a series of bar code images. Shortcut: Ctrl+L 

 
Help Open the documentation. Shortcut: F1 

7.4 Quality Watch – Status Section 

 
Figure 5: Quality Watch 

7.4.1 Deviation 

The less the deviation the better is the quality and the readability of the bar code. The deviation 
depends on the output resolution and the print ratio of the bar code. You can also improve the 
quality by changing the module width to an appropriate value  As measurement unit select “Pixel” 
and set the module width to an integer value (1, 2, 3, …, 25, …). 



http://www.tec-it.com/
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The Deviation field will report one of the following values: 

Tolerance Aberration Description 

Perfect 0% Optimal output quality.  

Fair 1-15% Should be readable with most bar code scanners. 

Poor 16-25% May be readable. 

Bad! 26-50% Not readable in most cases. 

Data Loss! 51-100% Total or partly loss of information. Unreadable bar code. 

Table 2: Bar code Qualities 

7.4.2 Quality 

The quality of the bar code – the higher the deviation, the lower is the quality. 

7.4.3 Character Count 

Displays the number of characters encoded in the bar code. 

7.4.4 Resolution 

The current output resolution in dpi (dots per inch). 

7.4.5 Hint Box 

The hint box () displays information about the current bar code quality and recommended actions 
to improve the readability. 

7.5 Barcode Types and Templates 

7.5.1 Barcode Type 

Select the barcode type (= symbology) from the Barcodes list (see Figure 3, ). 

► For 2D codes like Aztec Code, Codablock-F, PDF417, Micro QR-Code, MicroPDF, 
MaxiCode, Data Matrix, QR-Code, QR-Code 2005, GS1-DataBar Stacked variants, and for 
all Composite Symbologies you need a 2D license. For the other symbologies a 1D license 
is sufficient. 

If you want to learn more about the selected symbology, please examine the Barcode Reference 
from the Help menu. 

7.5.2 Template 

Select a template with a set of predefined settings from the Templates list. If you choose a template 
all previous settings are overwritten. 

You can add your current configuration to the templates by saving it with Save As Template… from 
the File menu. To refresh the template list choose the menu item Refresh Templates. 
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7.6 The Bar Code View 

 
Figure 6: Bar Code View 

The Bar Code View shows the bar code in its actual appearance (as it is will be printed). 

To change the size of the bar code, enter the required dimensions in the “Appearance” section (see 
section 7.7.2). The quality of the bar code depends on the output resolution and the module width. It 
can be observed in the Status section (see section 7.4). 

7.7 Page General 

7.7.1 Data 

 
Figure 7: Data Section 

7.7.1.1 Bar Code Data 

Enter the bar code content in the field “Barcode Data” (see ) or in the “Input Data” dialog (   ).  

 
Figure 8: Input Data (Dialog) 

The Input Data dialog allows you to enter the bar code data in a multi-line edit control and to import 
the data from a text file via the Load File…. Use the Reset button to clear the Data field. 

► Each bar code type is able to represent a specified set of data-characters. Some bar code 
symbologies can hold digits, others can contain alphanumeric characters (digits + letters + 
punctuation characters), or the full ASCII character set. 















 
 
 

Page 20 of 58 

 

Barcode Studio User Manual  

7.7.1.2 Add Control Characters 

You can enter control characters directly in the edit field or use the context menu. Open the context 
menu by right-clicking in the edit field and choose Add Control Characters. Then select the control 
character to insert from the submenu. 

Because control characters are represented by special character combinations (like \F for FNC1), 
Barcode Studio activates escape sequences automatically (see section 7.8.2.3).  

 

 
Figure 9: Add Control Character 

For more information on all available control characters, please refer to the “Barcode Reference” 
available from www.tec-it.com or via the menu Help ► Barcode Reference. 

7.7.1.3 Check Digit Override 

Some bar codes with a predefined number of utilizable data characters (like all EAN, UPC, Postnet 
and RSS-14 codes) contain a check digit on a fixed position in the bar code data. 

Example: 

 

 

The EAN13 code consists of 12 utilizable digits and 1 check digit on 
the last position (). 

If you enter 12 digits as bar code data the check digit will be 
calculated and inserted automatically. However, you can also enter all 
13 digits and override the calculated check digit. 

 

► Note: If the bar code data already contains a check digit, the barcode is valid only if the 
check digit equals to the automatically calculated check digit. 

► Only if the check digit method is set to None (see section 7.8.2.2), the correctness of a 
check digit remains unchecked. Under normal circumstances you should not use this setting 
– we recommend relying on the automatic calculation of the check digit(s) by Barcode 
Studio. 

7.7.1.4 Composite Data 

The Composite Data field () is only enabled if the selected bar code type supports composite data 
(check if the Composite page is visible) and if a 2D Composite Component has been selected 

(“Auto”, “CC-A”, “CC-B” or “CC-C”) on that page. 

► You can also enter the composite data in the Barcode Data field by separating the 
composite data from the linear bar code data by the vertical bar character "|". 

 

http://www.tec-it.com/
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7.7.1.5 Hex Data 

If this option () is selected the bar code data is treated as hexadecimal data. This property applies 
to the bar code data field as well as to the composite data. 

Whenever Hex Data is enabled, Barcode Studio treats manual entered data as well as imported 
data as a hexadecimal character sequence. This sequence is internally converted to a normal 
character sequence before a bar code is generated. 

7.7.1.6 Example Data 

If the option “Example Data” () is selected, Barcode Studio provides a valid example data string 
depending on the currently selected barcode type. The data is adapted automatically if you change 
the symbology. 

7.7.2 Appearance 

  
Figure 10: Appearance Section 

7.7.2.1 Unit 

This value () specifies the measurement units for displaying and/or entering the dimensions of the 
bar code. Possible values are:  

 Millimeter 

 Inch 

 Mils (=1/1000 inch)  

 Pixel. 

7.7.2.2 Dimensions (Width, Height) 

Use these settings to change the width () and the height () of the bar code.  

Unit Description 

Millimeter The width and the height of the bar code in millimeters. 

The physical width (in pixels) can be calculated as follows:  
width (pixels) = width (mm) / 25.4 * resolution (dpi) 

Inch The width and the height of the bar code in inches. 

The physical width (in pixels) can be calculated as follows:  

width (pixels) = width (inch) * resolution (dpi) 

Mils The width and the height of the bar code in mils. 

The physical width (in pixels) can be calculated as follows:  

width (pixels) = width (mils) / 1000 * resolution (dpi) 

Pixel The width and the height of the bar code in pixels. 

The width and the height are shown as physical (pixel) values. Basis for the displayed 
dimension is the size on the screen (in mm respectively in inch) and the adjusted resolution 
(dpi). 

Table 3: Units 
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7.7.2.3 Module Width () 

The bar code is divided into several "modules". A module is the smallest bar (or space) segment. 
The module width is the fundamental measuring unit for bar codes, i.e. all bar and space widths 
base on it.  

Depending upon the screen, printer, or image resolution, the lower limit for the module width may 
be exceeded. This leads to unreadable bar codes (e.g.: if the module width is smaller than 1 pixel).  

MaxiCode: This bar code type has a predefined constant module width to achieve the standard-
ized symbol dimensions. However, you can change the module width on demand. 

7.7.2.4 Resolution (DPI) () 

► The screen preview has a resolution of 72, 96 or 120 dpi (depending on your monitor and 
the display settings for your operating system). If you need to adjust a bar code for screen 
resolution, choose the setting with the same name in the Resolution select box. 

► To increase the accuracy of the bar code symbol you can increase its resolution.  

► However, only some professional layout applications consider the resolution correctly.  

► Most applications show (and print) the bar code image in screen resolution. This leads to an 
increased output size if the resolution is higher than screen resolution.  
Example: If your screen resolution is 96 dpi and the exported image has a resolution of 300 
dpi it will be displayed about 3 times as large as in Barcode Studio. 

► The dpi value can be stored by certain image formats only! For detailed information, please 
refer to Appendix C. 

 

Resolution (DPI) Description 

Screen Resolution Use the actual screen resolution (72, 96 or 120 dpi).  
The image will be exported in exactly the same size as you see it in Barcode Studio. 

Note: Under Windows XP the screen resolution is adjusted in the Control Panel ► Display ► 
Settings ► Advanced ► General: Display / DPI Setting. 

Printer Resolution Use the DPI setting of the currently selected printer. 

72 dpi (BMP) Create the image with 72 dpi. 

Custom Resolution… Create the image with the custom resolution added in the field aside. 

Other Create the image with the given dpi.  
Higher dpi values result in larger (and more detailed) image files. 

Table 4: Resolution Settings 

When exporting an image to a BMP or to PNG file, the adjusted resolution (dpi) will not be stored 
there. Only the formats JPG, TIF, and PCX are capable of storing the resolution. 

7.7.2.5 Optimal Size 

Barcode Studio provides this possibility to enhance the bar code quality and therefore the 
readability. This setting can be very helpful especially for lower resolutions. If the “Optimal Size” 
option () is checked, the module width of the bar code will be set to a whole-numbered pixel size 
(to the nearest lower value). Hereby the pixel deviation is reduced to a minimum or eliminated 
completely.  
In other words: The bar code is printed using whole-numbered pixel sizes only. This avoids aliasing 
effects and guarantees an optimal scanning quality. 

► If the “Optimal Size” option is checked, the module width will be adjusted for optimum output 
quality. 
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► The symbol in the bar code view can only be displayed with an optimum size, if the property 
is set to “Screen Resolution”. The screen preview is not detailed enough to display higher 
resolutions correctly. You will see the optimal result only on according output devices 
(printer, image, etc.). 

7.7.2.6 Reset Button 

Use the  button to reset all Appearance settings to their initial values. 

7.7.3 Text Placement 

In this section you can change the settings regarding the human readable text of the bar code. 

  
Figure 11: Text Placement Section 

7.7.3.1 Show Text 

If enabled, the “human readable text“ is displayed. (Default: enabled.) 

7.7.3.2 Print Text Above 

If enabled, the “human readable text” is printed above the bar code symbol and not below it. 
(Default: disabled). 

This setting cannot be enabled in conjunction with the bar code types UPC and EAN. 

7.7.3.3 Alignment 

This property adjusts the alignment of the human readable text (Default, Left, Right, and Center). 

7.7.3.4 Text Distance 

This property adjusts the distance between the “human readable text” and the bar code (in mm). 

7.7.3.5 Font 

Click the  button to select the font used for the human readable text. The selected font is 
displayed in the text box (). 
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7.8 Page Settings 

7.8.1 Drawing 

 

 
Figure 12: Drawing Section 

7.8.1.1 Print Ratio 

The print ratio describes the relationship between the widths of the single bars and spaces of a bar 
code related to the module width (do not mix up this item with the width/height ratio of a symbol!).  

The print ratio consists of a colon-separated-list of bar and space widths. The list starts with n bar 
widths, followed by m space widths. The numbers n and m depend on the bar code type. The width 
values are not given absolutely but relatively to the module width.  

 1   “Equal to the module width”,  

 2   “Twice the module width”,  

 … 

You can use the Default Print Ratio  as a template for a customized Print Ratio value. It shows 
how many different bar and space widths are used for the selected bar code type. The absolute 
width of a bar (or space) is calculated using the values of the print ratio multiplied with the module 
width. 

Example: If a bar code element has 4 different bar widths and 4 different space widths, the print 
ratio could look like this (e.g. for Code 128): 1:2:3:4:1:2:3:4.  
The first 4 numbers ("1:2:3:4") stand for the bar widths, the last 4 numbers for the space widths (in 
this case, they are the same). The smallest bar is "1" module wide, the next larger is "2" (thus twice 
as wide as the smaller bar) and so on. 

► Modifications within this area make only sense for special applications! For the Code 2OF5 
interleaved, e.g., the print ratio can vary from 1:2 to 1:3. 

► Use this option with care! Bar codes may become unreadable when setting wrong print 
ratios. 

For additional information on print ratios, please refer to the “Barcode Reference”. 

7.8.1.2 Bearer Bars 

Select the kind of bearer bars you want to use. Bearer bars help a decoder to detect the full width of 
a bar code and reduce the possibility of partial scans (decoding only a part of the symbol). You can 

change the width of the Bearer Bars in . 

7.8.1.3 Quiet Zone 

Click the Adjust Quiet Zones… button to open the Quiet Zones dialog.  

This property adjusts the sizes of the quiet zones around the bar code. The sizes can be given in 
several units like number of modules, Millimeters, Inches, Mils, and Pixels. 
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Figure 13: Quiet Zone 

You can configure the quiet zone on each side of the barcode independently from each other. By 
clicking Reset Values you can reset the sizes to zero. 

7.8.1.4 Bar Width Reduction 

When printing on inkjet printers, the ink that is absorbed by the paper tends to diffuse. Setting the 
bar width reduction allows you to work against this spreading of ink. But this property is also useful 
for laser printers with high toner saturation. 

The bar width reduction can be specified in several measure units like percent of the module width, 
mm, Inch, and Mils. Thus when the unit is set to percent and the value is set to 20 all bars will be 

narrowed by 20 percent of the module width. 

► Be careful: Setting the bar width reduction to more than 50 percent might leave the bar code 
unreadable! When using this feature we recommend you to do several test-scans to make 
sure that the bar code can be scanned correctly. A common value to start with is 15%. 

7.8.1.5 Notch Height 

This property adjusts the height at which the synchronization bars (e.g. the double lines in EAN on 
the left, center and on the right side) extend the regular bar code height. 

7.8.1.6 Colors / Transparency 

Click the Change Colors… button to open the Colors/Transparency dialog.  

 
Figure 14: Colors Dialog 

Click the  button beside the color you want to change and select the desired color in the 
following dialog. 

Fore Color:  The foreground color of the bar code (color of the bars) 

Back Color:  The background color of the bar code (color of the spaces) 

Text Color:  The color of the “human readable text”. 
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Back style: Mode for drawing the background of the bar code. The background can be set to 
transparent (= default, background shines through) or opaque (background is 
overwritten with the background color). This setting is also relevant if you use copy 
and paste (clipboard). 

7.8.2 Advanced Data Manipulation 

   
Figure 15: Advanced Data Manipulation Section 

7.8.2.1 Format/Subset 

The format string is used for formatting the utilizable data of the bar code according to defined rules. 
It operates with substitute symbols to indicate how the data shall be structured.  
With the format string it is possible to insert constant characters to the bar code data. Control 
characters make it possible to change the Subsets for Code 128, EAN 128 and UCC 128 or to 
define the desired start/stop character of CODABAR. 

For more information on format strings, please refer to the “Barcode Reference” available from 
www.tec-it.com or via the menu Help ► Barcode Reference. 

7.8.2.2 Check Digit 

This property specifies the check digit calculation method. In order to guarantee that the bar code 
data is going to be read properly a check digit can be added to the end of the utilizable data. A 
comparison of the bar code content with the check digit informs the scanning device (scanner) 
about incorrect scans and forces the device to repeat or reject the scan. The check digit calculation 
method is standardized for certain common bar codes types. Using check digits is mostly optional – 
but often recommended for particular symbologies and standards. 

When set to default the check digit is calculated according to the specification of the selected bar 
code. Modifications are admissible for bar codes with selectable check digit methods or for special 
applications only. 

For additional information on check digit calculation, please refer to the “Barcode Reference” 
available from www.tec-it.com or via the menu Help ► Barcode Reference.  

7.8.2.3 Encoding / Code Pages 

With the fields Encoding Mode () and Code Page () the user can affect the interpretation of the 

input data. 

For a general overview about encoding and code pages, please refer to the “Barcode Reference” 
available from www.tec-it.com or via the menu Help ► Barcode Reference. 

► Data is always passed as UNICODE stream to Barcode Studio. As UNICODE characters 
always consist of more than one byte and most of the barcode types are only able to encode 
one byte per character, it is not always clear how the input data should be interpreted. So we 
give you the possibility to decide yourself. 

► Per default the input data is converted to the selected Code Page (see below). If other kinds 

of interpretations are needed, you have to change this property. 

 

http://www.tec-it.com/
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http://www.tec-it.com/


 
 
 

Page 27 of 58 

 

Barcode Studio User Manual  

You have following possibilities: 

Value Description 

Selected Code Page Converts the input data to the code page, which is selected in the 
property Code Page. (default) 

Lo-Bytes only Considers only the lower bytes of the input characters, the higher 
bytes are ignored.  

Lo- before Hi-Byte The data is passed as it is. No conversion is done. All bytes are 
considered. The lower byte is passed before the higher byte. 

Hi- before Lo-Byte Consider both bytes but change the order of lower and higher byte. 
That means the higher byte is encoded before the lower byte. 

Table 5: Compression 

The code page is related to the property Encoding Mode. It is only considered if the encoding mode 
is set to Selected Code Page. You can choose between several pre-defined code pages (e.g. ANSI, 
ISO 8559-1 Latin I, UTF-8, Shift-JIS…) or add the ID of a custom code page by selecting Custom 
Encoding… and entering the ID in the edit field aside.  

7.8.2.4 Escape Sequences 

The use of escape sequences is appropriate if you need to encode control characters like carriage 
return or FNC1 into the bar code. 

This option specifies, whether escape sequences (like ”\n”) shall be translated or not (default: no). 
Each escape sequence starts with a backslash (“\”). For a list of recognized escape sequences, 
please refer to the additional document “Barcode Reference” available via the menu Help ► 

Barcode Reference or from www.tec-it.com. 

► If escape sequences are activated, the backslash character can‟t be used directly in the bar 
code data. It must be replaced by a double back-slash “\\” in order to be encoded correctly. 

 

7.9 Page Info 

7.9.1 User Info 

 
Figure 16: User Info Section 

http://www.tec-it.com/
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7.9.1.1 Title and Comment 

Users can enter a title and a comment in HTML-Format. If not left empty title and comment are 
displayed as info text below the barcode. The info text can be used to provide other users with 
necessary information. 

Possible fields of application:  

 Provide a short description of specific bar code settings. 

 Inform other users about the input data format. 

 Advice other users to perform the necessary steps to generate correct bar codes. 

 … 

 

 
Figure 17: Info Text 

To distribute settings with an info text, please perform following steps: 

► Change all settings according to your needs. 

► Enter the info text to the title/comment field. 

► Save the settings to a file. 

► Provide this file to all users who need it. 

 

7.9.1.2 Template Category 

The template category is used to categorize templates in the Templates tree. 
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7.10 2D Settings 

7.10.1 PDF417 / Micro PDF417 

 
Figure 18: PDF417 / Micro PDF417 Properties 

The PDF417 / Micro PDF417 page is used to modify the standard behavior of the two-dimensional 
PDF417 bar codes. PDF417 divides data contents into rows and columns – it is a stacked 
symbology with error correction capabilities. This page is not relevant to other symbologies. 

► Be careful when modifying these adjustments. Always make a test scan in case of doubt! 

7.10.1.1 Encoding Mode 

Determine whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for bar code generation with optimal speed. 

7.10.1.2 Rows [3..90] 

The number of rows. The value must be between 3 and 90.  

Default: the number of lines is calculated automatically depending on the number of input 
characters. 

► This property is not available for the Micro PDF417 symbology! 

7.10.1.3 Columns [1..30] 

The number of columns. The value must be between 1 and 30. Start-, stop- and line-indicator 
columns are not taken into account.  

Default: the number of columns is calculated automatically depending on the number of input 
characters. 

7.10.1.4 Row Height [mm] 

The height of an individual row in millimeter. If specified, the bar code height will remain locked at 
the specified value. (Modifying the bar code dimensions will only affect the bar code width.).  

Default: the row height is calculated automatically depending on the number of input characters. 
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7.10.1.5 Error Correction Level 

The error correction level. The value can be between 0 (only error detection) and 8 (highest 
correction).  

Default: the level is calculated automatically between 2 and 5 - according to the number of input 
characters. 

► This property is not available for the Micro PDF417 symbology! 

7.10.1.6 Mode 

Specifies how data is encoded as Micro PDF417. In most cases the “Default” mode is the best 
choice.  

► Note: Often the scanner hardware does not support all modes listed here – check with your 
scanner first. 

 

Mode (Enumeration) Description 

Normal (Default) Input data is analyzed. Text, numeric or binary compaction mode will be used according-
ly (to produce the smallest symbol). 

UCC/EAN-128 Emulation UCC/EAN-128 Emulation mode. Transmit ]C1 or ]L3. 

Use compaction for Application Identifier (AI) "01" + 14 digits. 

Code128 Emulation Code-128 Emulation mode. Transmit ]C2 or ]L4. 

Code128 FNC2 Emulation Code-128 with FNC2 on first position will be emulated. 

Linked UCC/EAN-128 Linked UCC/EAN-128 emulation. Transmit ]C1 or ]L3. 

Indicates that the Micro PDF symbol is linked with a linear symbol (which may be 
required for a successful scan). 

Using this mode, the following AIs can be encoded with better compaction in the given 
order: 

 Date (AI 11, 13, 15 or 17) + lot number (AI 10) + other AI‟s (optional). 

 Date (AI 11, 13, 15 or 17) + serial number (AI 21) + other AI‟s (optional). 

 Date (AI 11, 13, 15 or 17) + other AI‟s (optional). 

Note: This mode is not used with UCC EAN Composite Symbology, which uses linked 
symbols, too. 

05 Macro The preamble [ ( > RS 0 5 GS precedes the encoded data. 

06 Macro The preamble [ ( > RS 0 6 GS precedes the encoded data. 

CC-A Data Mode For special applications only: use Base-928 compaction and process input data as byte 
array. 

CC-B Data Mode For special applications only: use binary compaction (Base-900), prefix symbol data with 
reserved symbology code word. 

Table 6: Micro PDF417 - Modes 

► This property is not available for the PDF417 symbology! 

7.10.1.7 Version 

Specifies the “size” of the symbol in terms of codeword-columns and Micro PDF417 rows. 

► This property is not available for the PDF417 symbology! 

7.10.1.8 Macro PDF417 (Structured Append) 

Inserts a Macro PDF control block into the bar code. 

PDF417 allows the user to spread the data across several symbols. This might be done if the data 
is too large to fit into a single symbol or for reasons of appearance and geometry. 
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The so called “Macro PDF Control Block” carries information that relates its contents to the overall 
data. The below described properties are mandatory for the Macro PDF functionality. 

7.10.1.9 Segment Index 

Index of the actual data segment in the symbol chain. Start with 1 and increase for each additional 
symbol in the data chain. Value range = 1…99999.  
Note: when reading the encoded data with a scanner, the index will be zero-based. 

7.10.1.10 Last Symbol 

Identifies the last symbol in the data chain. If set to true, the “Last Segment Indicator” is put at the 
end of the Macro PDF control block. 

7.10.1.11 File ID 

The file id identifies all symbols, which belong to the same data chain. For reassembling, all data 
blocks having the same File ID are concatenated in the order of increasing segment index. 

7.10.1.12 Advanced (optional fields) 

These fields are optional and may be encoded into the Macro PDF417 control block on demand. 

 
Figure 19: Macro PDF417 Optional Settings 

File name (alphanumeric) File name (variable length field). 

Segment count (numeric) Total number of data segments (range 1…99999). 

Time stamp (numeric) Time stamp (elapsed time in seconds since January 1, 1970 00:00 GMT). 

Sender (alphanumeric) Sender (variable length field). 

Addressee (alphanumeric) Addressee (variable length field). 

File size (numeric) Total number of bytes encoded (variable length field). 

Checksum (numeric) 16-Bit CRC checksum (using CCITT-16 polynomial x16 + x12 + x5 + 1 over the 
entire data). 

7.10.2 MaxiCode 

MaxiCode represents data, by drawing hexagonal items, which are arranged around a circular 
center (a so called "Bull's Eye"). The internal data structure is regulated by different "modes". The 
mode "Structured Carrier Message" was defined by the parcel transport service UPS

®
. Data can be 

encoded in two different error correction levels (SEC = Standard Error Correction and EEC = 
Enhanced E.C.). 



 
 
 

Page 32 of 58 

 

Barcode Studio User Manual  

With “Structured Append” you can divide larger quantities of data into several MaxiCode symbols – 
they are joined by the scanner. The maximum data capacity of one symbol is 93 characters. The 
actual quantity of the utilizable data depends on the selected mode, how often special characters 
are used, whether numeric sequences, which can be compressed, are used and which level of error 
correction is adjusted. 

 
Figure 20: MaxiCode Properties 

7.10.2.1 Mode 

Mode (Enumeration) Description 

4 – Standard Symbol For numeric and alphanumeric character sequences (incl. standard error correction). 

2 – SCM (Numeric) Structured Carrier Message, up to 9 digits (postal code consist of digits only). 

3 – SCM (Alphanumeric) Structured Carrier Message, up to 6 characters (postal code consist of alphanumeric 
characters). 

5 – Full EEC Like mode 4 but with enhanced error correction (safer, but fewer utilizable data 
possible). 

Table 7: MaxiCode - Modes 

7.10.2.2 Undercut [0..100] 

The undercut influences the diameter of the hexagonal bar code elements. In new applications it is 
recommended (according to the AIM standard) to use an undercut setting of 75% (default). 

7.10.2.3 Preamble Options 

Used particularly in “Open System Standards”. Under “Preamble Date” the last two digits of a year 
can be entered. They are inserted automatically into the data stream in a predefined place. 

7.10.2.4 Structured Append 

If you want to “connect” several MaxiCode symbols in order to encode larger quantities of data, then 
you can use “Structured Append". A symbol identification number which is entered in the “Index of 
this Symbol” field can be assigned to each MaxiCode symbol. Its value can range between 1 and 8. 
This index indicates the order, in which the data is joined after the reading/scanning process. The 
total number of arranged MaxiCode symbols must be entered in “Number of all symbols”. 

7.10.2.5 Structured Carrier Message (SCM) 

MaxiCode was originally developed by UPS
®
 (United Parcel Service). In the operating mode 

"Structured Carrier Message" (mode 2 and 3) there are defined data fields for UPS
®
-purposes. 

These can be entered in the fields ”Service Class”, ”Country Code”, and ”Postal Code”. In “Mode 3” 
you can use digits as well as alphanumeric characters for the “Postal Code”. 
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By using escape sequences it is possible to insert the values for date, preamble, service class, 
country and postal code directly into the bar code data (text property). To learn more about this 
possibility, please refer to the additional document “Barcode Reference” available from www.tec-
it.com or via the menu Help ► Barcode Reference. 

7.10.3 Data Matrix 

► Please note, that Barcode Studio always uses ECC 200 error correction. 

 

 
Figure 21: Data Matrix (ECC200) Properties 

7.10.3.1 Code Format 

Code Format  (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry Supports peculiar industry formats (FNC1 at 2nd position). 

Macro 05 [)>Rs05Gs is encoded at the beginning of the code. 

Macro 06 [)>Rs06Gs is encoded at the beginning of the code. 

Reader Programming Format used to program barcode reading devices. 

DP Postmatrix Special Format defined by „Deutsche Post“. Is used for mailing commercials. 

Table 8: Data Matrix - Modes 

7.10.3.2 Symbol Size 

The size of the symbols in number of rows and columns. Possible sizes are "10 x 10" to "144 x 144" 
modules for square symbols and "8 x 18" to "16 x 48" for rectangular symbols. If set to default, the 
minimal possible square size is used (depending on the input data). 

7.10.3.3 Enforce Binary Encoding 

Determine whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for bar code generation with optimal speed. 

7.10.3.4 Show as Rectangle 

Determines if the Data Matrix symbol should be displayed as a rectangle (option is checked) or a 
square (unchecked - default). 

http://www.tec-it.com/
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7.10.3.5 Structured Append 

If you want to “connect” several Data Matrix symbols in order to encode larger quantities of data, 
then you can use “Structured Append". A symbol identification number - which is entered in the 
“Index of this Symbol” field - can be assigned to each Data Matrix symbol. Its value can range from 
1 to 16. This index indicates the order, in which the data is joined after the reading/scanning 
process. The total number of arranged Data Matrix symbols must be entered in “Number of all 
symbols”. The “File ID” has to be the same for all symbols within such a chain. 

7.10.4 QR-Code / QR-Code 2005 / Micro QR-Code 

The QR-Code symbology is a 2-dimensional matrix symbology (similar to Data Matrix). Remarkable 
is the large data capacity (up to 3000 ASCII characters or 7000 digits). QR Code means Quick 
Readable code – it was originally designed to read and decode symbols with high amounts of data 
within a minimum of time. The only difference between QR-Code and QR-Code 2005 is the default 
code page. Whereas QR-Code uses Japanese Shift-JIS, QR-Code 2005 uses ISO 8859-1 Latin I. 

The Micro QR-Code symbology is based upon QR-Code, but is adapted to encode only small 
quantities of data. It produces less overhead and smaller symbols. 

 
Figure 22: QR-Code Properties 

7.10.4.1 Format / Application Indicator 

Format (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry For special industry formats (FNC1 is inserted at second position). If you choose this 
value, you also have to fill in the field Application Indicator (2 digits or 1 letter). It 
determines to which industry format the input data (should) correspond(s). 

Table 9: QR Code – Modes 

► This property is not available for the Micro QR-Code symbology! 

7.10.4.2 Symbol Version (Size) 

Specifies the version (= size) of the symbol, defined by a version number, the number of rows and 
the number of columns. The range for QR-Code symbols is from „(1) 21 x 21" up to „(40) 177 x 177" 
modules for square symbols. The range for Micro QR-Code symbols is from “(M1) 11x11” to “(M4) 
17x17”. 

If the property is set to default, the size is computed automatically based on the data to be encoded. 
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7.10.4.3 Error Correction Level 

Defines the error correction level. You can choose from following possible values: 

Error Correction Level (Enumeration) Description 

(L)ow Lowest level. Data recovery capacity is up to approximately 7%. 

(M)edium (default) Up to 15%. 

(Q)uartil Up to 25%. 

(H)igh Highest level. Up to 30%. 

Table 10: QR Code – Error Correction Levels 

► Depending on the selected version, Micro QR-Code does not support all levels of error 
correction. If a level is selected, which is too high for given symbol version, Barcode Studio 

automatically uses the highest possible level. 

7.10.4.4 Mask Pattern 

Specifies the mask pattern that is applied to the symbol to improve the readability of the code. 

Mask Pattern (Enumeration) Description 

Default The mask pattern is calculated automatically. 

0..7 (QR-Code only) With the values 0 to 7 you choose the appropriate mask pattern. It would 
make sense to specify this setting directly, especially, if you have to 
optimize computation time. The algorithm to calculate the optimal mask is 
rather complex (and therefore very resource consuming). 

0..3 (Micro QR-Code only) With the values 0 to 3 you choose the appropriate mask pattern. It would 
make sense to specify this setting directly. Compared to QR-Code the 
mask algorithm for Micro QR-Code is rather fast and simple. 

Table 11: QR Code – Mask Patterns 

7.10.4.5 Compaction 

The multi-byte compaction mode. QR Code provides code compaction for various Multi Byte 
character encodings (Kanji, Chinese). This compaction can help to produce smaller bar codes. 

Compaction (Enumeration) Description 

Default multi byte compaction (Default) Automatically chooses the appropriate compaction method. 

No multi byte compaction Disables the multi byte compaction. 

Kanji character compaction Enables the compaction for Kanji characters. 

Chinese character compaction Enables the compaction for Chinese characters. 

Table 12: QR Code – Compaction 

QR-Code supports compaction of Kanji characters (if present in the Multi Byte character set Shift 
JIS X 0208). The Kanji characters are compacted into a 12-Bit codeword (instead of a 2 Byte / 16 
Bit codeword) – so you need less space in the symbol. It is recommended to enable this 
compaction only if you have Kanji characters in your input data. Enabling is not recommended for 
binary data. 

7.10.4.6 Structured Append 

If you want to “connect” several QR Code symbols in order to encode larger quantities of data, then 
you can use “Structured Append". A symbol identification number which is entered in the “Index of 
this Symbol” field can be assigned to each QR Code symbol. Its value can range from 1 to 16. This 
index indicates the order, in which the data is joined after the reading/scanning process. The total 
number of arranged symbols must be entered in “Number of all Symbols”. 
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Chained QR Code symbols are identified by the parity byte. The parity byte must be identical in all 
symbols. The value can be calculated using the method „QR_StructAppParity“, which is part of 
TBarCode.  

► This property is not available for the Micro QR-Code symbology! 

7.10.5 Aztec Code 

 
Figure 23: Aztec Code Properties 

7.10.5.1 Format / Format Specifier 

Code Format (Enumeration) Description 

Default Standard format. 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN. Used for encoding Application Identifiers. 
(FNC1 at 1st position). 

Industry For special industry formats (FNC1 is inserted at second position). If you choose this 
value, you also have to fill in the field Application Indicator (2 digits or 1 letter). It 
determines to which industry format the input data (should) correspond(s). 

Table 13: Aztec Code – Modes 

7.10.5.2 Symbol Size 

Defines the size of an Aztec Code symbol by the number of rows and columns. Possible values 
range from „15 x 15" up to „151 x 151" modules. If the property is set to default, the size is 
computed automatically based on the data to be encoded. 

7.10.5.3 Enforce Binary Encoding 

Determine whether to enforce binary encoding. In Binary Encoding mode the encoding algorithm 
does not try to calculate the smallest possible symbol, but it uses binary encoding for all characters. 
This is recommended for binary input data and for bar code generation with optimal speed. 

7.10.5.4 Aztec Runes Mode 

Enables the Aztec Runes mode. Aztec Runes are a special kind of Aztec Code Symbols and are 
used to generate small and very fast readable markers. Aztec Runes can only encode integer 
values from 0 to 255. 

7.10.5.5 Error Correction 

Defines the error correction level. The value can be between 1 and 89 percent.  

Default: the level is set to 23 percent. 
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7.10.5.6 Structured Append 

If you want to “connect” several Aztec Code symbols in order to encode larger quantities of data, 
then you can use “Structured Append". A symbol identification number which is entered in the 
“Index of this Symbol [A..Z]” field can be assigned to each Aztec Code symbol. Its value can range 
from “A” to “Z”. This index indicates the order, in which the data is joined after the reading/scanning 
process. The index of the last Symbol must be entered in “Number of all Symbols [A..Z]”. 

Chained Aztec Code symbols are identified by the “Message ID”. The “Message ID” must be 
identical in all symbols. 

7.10.6 Codablock-F 

The Codablock-F property page is used to adjust symbology specific parameters. Similar to PDF-
417 the data content is divided into rows and columns. Codablock-F is a stacked symbology with 
additional internal checksums for error recognition.  

Codablock-F is based upon the Code 128 symbology - one data row consists of a single Code 128 
bar code extended with row identifiers and column check sum.  

► Have caution when modifying these adjustments. Always make a test scan in case of doubt!  

 

 
Figure 24: Codablock-F Properties 

7.10.6.1 Code Format 

Code Format  (Enumeration) Description 

Standard Standard format 

GS1/UCC/EAN Special format defined by GS1/UCC/EAN to be used in GS1/UCC/EAN 
applications. 

Table 14: Codablock-F – Modes 

7.10.6.2 Rows [2..44] 

The number of rows used for encoding. The value must be between 2 and 44. Default: the number 
of lines is calculated automatically depending on the number of input characters. 

7.10.6.3 Columns [4..62] 

The number of columns (in data words), which are to be printed. The value must be between 4 and 
62. Start-, stop- and line-indicator columns are not taken into account. Default: the number of 
columns is calculated automatically depending on the number of input characters. 
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7.10.6.4 Row Height [mm] 

The height of an individual row in millimeter. If specified, the bar code height will remain locked at 
the specified value. (Modifying the bar code dimensions will only affect the bar code width.) Default: 
the row height is calculated automatically depending on the number of input characters. 

7.10.6.5 Separator Height [mm] 

The width of the row separator line in millimeter. Default: the line width is equal to the module width 
(calculated automatically depending on the symbol size).  

7.10.7 Composite Symbology 

 
Figure 25: Composite Symbology Settings 

Composite components are available for the following bar codes: 

 EAN8 

 EAN13 

 GS1-DataBar / RSS14 

 GS1 DataBar Stacked / RSS14 Stacked 

 GS1 DataBar Stacked Omnidirectional / RSS14 Stacked Omnidirectional 

 GS1 DataBar Truncated / RSS14 Truncated 

 GS1 DataBar Expanded / RSS Expanded 

 GS1 DataBar Expanded Stacked / RSS Expanded Stacked 

 GS1 DataBar / RSS Limited 

 GS1-128 / UCC/EAN128 

 UPC-A 

 UPC-E 

 

► By default Composite Component Symbologies are set to disabled.  
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7.10.7.1 2D Composite Component 

None Composite Symbologies are disabled. 

Auto Automatically choose CC-A, CC-B or CC-C Symbology depending on the length of the input data. 

CC-A CC-A is a variant of the MicroPDF417 Symbol with a unique combination of row address patterns 
(RAP). It is the smallest variant of the 2-dimensional composite component. Up to 56 digits of 
alphanumeric data can be coded with 3 to 12 rows and 4 columns. 

CC-B CC-B is a subset of the MicroPDF417 Symbol, which is identified by the code word 920. Encoding 
systems choose CC-B automatically when CC-A has not enough capacity (Auto-mode). CC-B 
encodes up to 338 digits of alphanumeric data in 3 to 12 rows and 2 to 4 columns. 

CC-C The CC-C structure is a PDF417 Symbol, which is identified by the internal code word 920 (920 is the 
first code word after the symbol length indicator). The CC-C structure can be used as a 2 dimensional 
composite component of a UCC/EAN-128 Composite Symbols. It has the largest data capacity of 
EAN.UCC Composite Symbols because of its possibility to code of up to 2361 numbers. It can code 
numbers with up to 2361 digits of alphanumeric data, which have 3 to 30 rows and up to 30 Data-
Error-checking-Code-Columns. 

7.10.7.2 Segments per Row 

This property adjusts the number of (graphical data) segments per row in the GS1 DataBar 
Expanded Stacked (RSS) Symbol. This parameter influences the width of the bar code. “Default” 
means that each row contains at least 4 segments. 

► This property is only used by the bar code type GS1 DataBar Expanded Stacked (RSS). 
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8 Data List 

8.1 General 

The data list feature can be used to produce series of bar code images. The data can be imported 
from files, generated by a sequence generator, or edited manually by the user. 

Go to the Data List tab to see following view. 

8.2 Data List View 

  
Figure 26: Data List View 

The data list () contains a list of bar code data, which can be used to export series of bar code 

images. The data can be inserted, updated, or deleted manually (), imported from a text file or 

generated automatically by a sequence generator (). Finally the data list is exported as a series of 

image files ().  

8.2.1 List Content 

8.2.1.1 Generate 

Generate determines whether the data row shall be exported. This value is checked by default. 

8.2.1.2 Status 

The status column informs the user whether a bar code can be created successfully ( ) - that 

means the data is valid for the given settings - or not ( ).  

To get a detailed error message select the data row with the error icon. The error message is 
shown in the Barcode View above. 

8.2.1.3 Data 

This column contains the bar code content. This value is mandatory for bar code generation and 
may not be empty. Values can be edited manually, imported from a file or generated with the 
sequence generator. 
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8.2.1.4 Composite Data 

Composite Data contains the content of the composite part of a bar code. It is only used in 
connection with composite bar code types. So this column is only visible if a composite bar code 
type is selected. It can be edited manually or imported from a file. 

8.2.1.5 File Name 

This column contains the name of the exported file. The file names can be edited manually, 
imported from a file, or generated automatically during export. 

8.2.1.6 Exported At 

Exported At contains the time when the bar code was exported the last time successfully. It is 
generated automatically during export and cannot be changed by the user.  

8.2.1.7 Comment 

The user may enter comments for the data list here. 

8.2.2 Symbol Size / Module Width 

By default all bar codes in the data list have the same module width. That means bar codes with 
different contents may vary in size but the minimum bar width and the quality will be the same for 
each bar code.  

The user has also the possibility to generate bar codes with (nearly) the same symbol size (but 

different module width). He can do this by checking the field Lock Symbol Size ().  

8.2.3 Editing 

8.2.3.1 Add New Entries 

The user can append a new bar code entry by clicking the New-button. All columns are empty and 

have to be filled by the user. 

8.2.3.2 Edit the Data List 

The user can edit the data directly in the list by double-clicking the list entries (or pressing F2). He 
may change the Data, the Composite Data, the export File Name, and the Comment. The Data 

column is mandatory, all others are optional. 

8.2.3.3 Delete Entries 

By clicking the Delete-button the user has the possibility delete one or more selected data list 
entries. 

8.2.3.4 Refresh 

The Refresh-Button updates the error status of the data list entries. 

8.2.4 Error Status 

The status icons inform the user whether the data content of each row is valid for the actual bar 

code settings().  
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Figure 27: Error Status 

In order to avoid long update times, the error status is not kept up-to-date. So the user has to click 

Refresh to see the real error status (). 

If at least one data row produces an error, the user is informed by a warning box about how many 

data rows are invalid (). 

8.3 File Import 

8.3.1 Import Dialog 

8.3.1.1 File 

Enter or choose the file name of the import file. The file must be a character-separated-text file 
(*.csv, *.tsv, etc.). The data rows are separated by line breaks and the columns by a specified 

separator character ().  
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Figure 28: File Import 

8.3.1.2 Field Separator and Text Qualifier 

The field separator divides data rows into several columns. Frequently used separator characters 
are commas (,), semicolons (;), and tabulators, but the user can specify any character he likes 

(). 

If the import data contains separator characters within a single column, the user has the option to 
specify a text qualifier character. All characters between 2 related text qualifiers are handled as unit. 

Often used text qualifiers are quotes (‘) and double quotes (“) (). 

8.3.1.3 First Row Contains Column Names 

If this setting is checked the first row is assumed to contain the column names (). 

8.3.1.4 Preview and Status 

As soon a valid file name has been specified the preview shows the first lines of the imported file 

(). The status field below () informs the user about the import status and how to proceed. 
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8.3.2 Data Mapping 

 
Figure 29: Data Mapping 

Each column of the imported file can be mapped to Data column, the Composite Data column, and 
the File Name column of the data list. The Data column is mandatory, all others are optional. 

At last press Ok to import the file into the data list. 

8.4 Sequence Generator 

  
Figure 30: Sequence Generator 
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By clicking Sequence… the user opens the Sequence Dialog with the sequence generator. The 
sequence generator allows the user to fill the data column of the data list with a formatted serial 
number. 

8.4.1 Start Value / End Value / Increment 

The range of a sequence is specified by the Start Value, the End Value, and the Increment. The 
start value defines the lower bound of the range, the end value the upper bound, and increment the 

step size between consecutive list items.  () 

► The last value of the sequence will never exceed the number specified in End Value.  

8.4.2 Format 

The Format defines the pattern, which will be applied to the items of the sequence (). The format 

string may contain 3 kinds of placeholders, which are replaced by the digits of a serial number 
during generation. All other characters are left as they are. 

Character Description 

# Barcode Studio inserts leading blanks instead of the placeholders if the number of characters given in 
Format string exceeds the number of characters in the item of the sequence. 

$ Like “#” but insert leading zeros instead of blanks. 

* Like “#” but insert leading stars instead of blanks. 

 All other characters are used literally. 

Table 15: Format - Characters 

Examples: 

Format 
String 

Sample Output Description 

$$ 01, 02, 03, …, 10, 11 Leading zeros 

##   1,   2,   3, …, 10, 11 Leading spaces 

**  *1, *2,  *3, …, 10, 11 Leading asterisks 

00$$ 0001, 0002, 0003, …, 0099 Like “$$” but with “00” as constant prefix 

A$$ A01, A02, A03,… Like “$$” but with “A” as constant prefix 

Table 16: Format - Examples 

► If you enter “$$$” and create a sequence containing numeric values higher than 999, the bar 
code data will be truncated. In this case change the format string. 

8.4.3 Create 

Create the sequence based on the settings specified above. Please click Create to see a preview 

() of the generated sequence. 

At last press Ok to insert the sequence into the data list. 
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8.5 Export 

  
Figure 31: Export Dialog 

By clicking Export… the Export dialog opens. Here the user can specify the destination directory 

(), the file names (), and several other settings. 

8.5.1 Export Settings  

8.5.1.1 Destination Path 

The destination path specifies to which directory the export images shall be saved.  

8.5.1.2 File Format 

Specify the file format of the export file. Please also refer to Appendix C.  

8.5.1.3 Check the Bar Code Data before Export 

If this field is checked, the bar code data is checked before the export and the user is informed 
whether the data list contains invalid data.  

8.5.1.4 Export EPS Files with a TIFF Preview 

If this field is checked, a TIFF preview is added to the generated EPS files. The check box is only 
active if one of the EPS file formats is selected. 
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8.5.2 File Name Generation  

8.5.2.1 File Name Prefix 

The file name prefix is prepended to the generated file name.  

8.5.2.2 File Name 

The user has the possibility to choose between following file name generation methods: 

Generation Method Description 

Same as Data The file name is based on the bar code data (sequence data). For instance if you encode 
“12345” in the bar code, the file name will be prefix + 12345.bmp. Ideal for numeric values 
and for easy bar code to image file assignment. 

Note: if the sequence data contains characters that are not allowed for file names, use 
URL-encoding. 

Serial Number The image file names are based on serial numbers starting with 1. The user can specify 

the number of digits of the generated numbers (). 

Table 17: Sequence – File Name 

8.5.2.3 URL-Encoding 

If checked, the file names are URL-encoded. That means that characters that are not allowed in file 
names are escaped by a percent sign followed by the hexadecimal ASCII code. 

Character HEX-Code Character HEX-Code Character HEX-Code 

\ %5C / %2F : %3A 

* %2A ? %3F “ %22 

< %3C > %3E | %7C 

% %25     

8.5.2.4 Keep User Defined File Names 

If checked, the file names, which are already defined in the data list, are kept. If unchecked all file 
names are overwritten by the file generation. 

8.5.3 Preview 

The preview demonstrates how the generated file names will look like. () 

8.5.4 Export 

By clicking Ok the bar code images are exported. 

If at least one image file cannot be generated, an error message will be shown. This may have one 
of the following reasons: 

 A value of the sequence item list cannot be encoded by the actual selected bar code type 
(e.g.: symbology 2of5 IL may only contain digits). 

 An invalid file name has been generated (e.g. if you have a backslash in the data and “Data 
URL-Escaped” is not used). 

Keep in mind that exporting many sequence items can take a lot of time and hard drive space! 
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9 Options 

In the Options dialog you can change general settings. You can open the Options dialog via the 
menu Tools ► Options…   

After pressing Ok the options are saved in the file bcstudio.bcopt, which is located under the 
Application Data/Program Data directory (e.g. C:\ProgramData\TEC-IT\BCStudio\10.0) and is 
loaded each time Barcode Studio is started. 

  
Figure 32: Options Dialog 

9.1 Output 

9.1.1 Draw Mode 

To handle different printer driver implementations, you are able to choose from several draw 
modes.  

Draw Mode Description 

Default 

Advanced 

The bar codes are drawn in the advanced mode. This provides the best quality. 

Compatible The bar codes are drawn in the compatible mode. This decreases the quality slightly, but is 
supported by the most printers. 

Dual The bar codes are drawn in the dual mode. This is a combination of the Advanced and 
Compatible mode. 

Table 18: Draw Modes 

9.2 EPS Export 

9.2.1 Add Preview (TIFF) 

Many applications are not able to process Postscript, and so they often display embedded EPS 
documents only as placeholder (such as empty rectangles, etc.). To give the user a chance to see 
the content of such an embedded document also in previews and design views, the EPS generator 
offers the possibility to include a preview image into the file. 

The preview in TIFF format is supported by many applications (unfortunately not by all). 





 
 
 

Page 49 of 58 

 

Barcode Studio User Manual  

► If the preview mode is enabled, the size of the generated EPS files increases by the 
multiple of the original file size. So the preview mode should be disabled if many 

documents have to be printed. 

 

9.2.2 Font Substitution 

Font Substitution is only used when exporting the barcode to an EPS file. This is an advanced 
option and should only be changed for special applications. 

Font Substitution Description 

None The font won‟t be substituted, unless it is a invalid one 

Automatic (Default) The font will always be substituted with an appropriate one. 

Fixed Font The font will always be substituted with the font specified in “Surrogate Font” 

Table 19: Font Substitution 

9.2.3 Surrogate Font 

The font used for EPS exports. This property overrides the “Font” property on the “General” tab, but 
only if “Font Substitution” () is set to “Fixed Font”. 

9.3 Templates 

9.3.1 Template Directory 

Barcode Studio browses the template directory for template files (.bc), which are listed in the 
template tree on the main window. The template directory is preset by the setup, but may be 
changed afterwards if the user wants t use a custom set of templates. 
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10 FAQ 

► Please check out the TEC-IT Barcode Reference for bar code (and parameter) related 
questions. You can download it from:  
http://www.tec-it.com/download/PDF/Barcode_Reference_EN.pdf 

► More Information can be found on our website  
 http://www.tec-it.com/support/faq/Default.aspx or by contacting our support team: 
support@tec-it.com. 

10.1 How can I encode the FNC1 character in EAN128? 

Check (activate) “Escape Sequences” (Page Settings) and insert the following escape code into the 
data: 

Control character Escape sequence Bar code type(s) 

FNC1 \F Code 128, EAN128, UCC128, GS1-128, GS1-DataBar 

EAN.UCC Composite Symbology 

Read more about Application Identifiers (EAN/UCC/GS1) in our Barcode Reference. 

10.2 How can I encode the FNC1 character in GS1/UCC/EAN Data Matrix? 

Set the Data Matrix Code Format to GS1/UCC/EAN (Data Matrix Tab), check Escape Sequences 

(Settings Tab) and insert the following escape code into the data: 

Control character Escape sequence Bar code type(s) 

FNC1 \F EAN Data Matrix 

Read more about Application Identifiers (EAN/UCC/GS1) in our Barcode Reference. 

10.3 Escape-Sequences are not encoded (and the scanner signals an error) 

Escape sequences are starting with “\” and enable encoding of special characters. They are 
translated before the bar code is created. 

Some scanners have problems with the backslash. Escape sequences are only translated if the 
checkbox “Escape Sequences” is checked in the Settings Tab (see section 7.8.2.3). Otherwise you 

will find the original character sequence (e.g. „\t“) in your data and not the special character. 

10.4 After saving the bar code to an image file, my bar code scanner cannot 
read the bar code! 

The bars and spaces in the symbol must have precise widths. By creating a bitmap image from the 
bar code, the widths are adapted to the matrix of the bitmap. Depending on its resolution more or 
less deviations can occur. The lower the resolution, the more differences in the width of bars/spaces 
will appear. 

There are different strategies to overcome these problems - please check out the section 
“Resolution and Readability” in the Barcode Reference for more information. 

http://www.tec-it.com/download/PDF/Barcode_Reference_EN.pdf
http://www.tec-it.com/support/faq/Default.aspx
mailto:support@tec-it.com
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11 Licensing 

11.1 License Types 

Please check out http://www.tec-it.com/order/Default.aspx for available license types and pricing. 

11.2 Entering your License Data 

The license information is entered in the following dialog. To enter the license data select Help ► 

License… from the menu. Usually the software is activated online (see 11.2.1): 

► Online activation is not possible or do you prefer manual activation?  
Please get in touch us with us if your system has no internet access or if you prefer to use 
the manual activation for any reason. We will be glad to send you the license data which is 
suitable for manual licensing (see 11.2.2) without internet access. 

11.2.1 Online Activation using an Activation Key 

The online product activation () is the preferred licensing method if you received an activation key 
from TEC-IT. 

 
Figure 33: License Dialog - Online Activation 

In the topmost field () you have to enter your activation key. All fields are required. A license 
certificate is sent to the given Email address () automatically.  

Confirm by clicking “Send”. A message informs you about the successful activation. In case of 

problems or errors please get in touch with TEC-IT. 

 







http://www.tec-it.com/order/Default.aspx
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11.2.2 Manual Licensing 

Manual licensing is the alternative method for licensing if your system has no Internet connection. 
Select Manual licensing () and enter the license data as provided by TEC-IT. 

► Please enter the license data exactly as you received it from TEC-IT!  
Spacing and upper/lower case letters are to be considered. To avoid typographical errors, 
please insert the data using “copy and paste” from the email containing your license data 
whenever possible.  

► Single licenses   
If you purchased a Single License, you need to provide the so-called "System ID” (or 
hostname on LINUX and MAC) of the target computer. You can find the System ID (or 
hostname) in the licensing dialog of Barcode Studio (see below). 

 

 
Figure 34: License Dialog – Manual Licensing 

Perform the following steps to enter the license data: 

1. On the top of the dialog you find the System ID
1
 () of your computer.  

2. For field "Product” please choose between “Barcode Studio 1D (Linear Codes)” and 
“Barcode Studio 2D (1D + 2D Codes)”. 

3. In the field "Licensee” enter the name of the license holder. 

4. In field "Kind of License”, please select the kind of license that you have purchased. You can 
choose among: 

       Single 

       Site 

       Enterprise 

5. The field "Number of Licenses” should be filled with the number of licenses that you 
purchased. 

6. In the field "Your License-Key” please enter the license key exactly as received from TEC-IT. 

7. Confirm the dialog with OK. 

  

 

                                                                 
1
 On UNIX, Linux or Mac OS X the hostname of the system is used as System ID (relevant only for Single licenses) 
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12 Contact and Support Information 

 
TEC-IT Datenverarbeitung GmbH 
 

Address: Wagnerstr. 6  

AT-4400 Steyr  

Austria/Europe 

Phone: +43 / (0)7252 / 72 72 0 

Fax: +43 / (0)7252 / 72 72 0 – 77 

Email: office@tec-it.com 

Web: http://www.tec-it.com 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

AIX® is a registered trademark of IBM Corporation.  
HTML, DHTML, XML, XHTML are trademarks or registered trademarks of W3C, World Wide Web Consortium, Laboratory for Computer 
Science NE43-358, Massachusetts Institute of Technology, 545 Technology Square, Cambridge, MA 02139.  
JAVA® is a registered trademark of Sun Microsystems, Inc., 901 San Antonio Road, Palo Alto, CA 94303 USA.  
JAVASCRIPT® is a registered trademark of Sun Microsystems, Inc., used under license for technology invented and implemented by 
Netscape.  
Linux® is a registered trademark of Linus Torvalds in several countries. 
UNIX® is a registered trademark of The Open Group 
Microsoft®, Windows®, Microsoft Word®, Microsoft Excel® are registered trademarks of Microsoft Corporation.  
Navision is a registered trademark of Microsoft Business Solutions ApS in the United States and/or other countries. 
Oracle® is a registered trademark of Oracle Corporation. 
PCL® is a registered trademark of the Hewlett-Packard Company. 
PostScript® is a registered trademark of Adobe Systems Inc. 
SAP, SAP Logo, R/2, R/3, mySAP, ABAP, and SAPscript are trademarks or registered trademarks of SAP AG in Germany (and in several 
other countries).  
 
All other products mentioned are trademarks or registered trademarks of their respective companies. If any trademark on our web site or in this 
document is not marked as trademark (or registered trademark), we ask you to send us a short message (office@tec-it.com). 

mailto:office@tec-it.com
http://www.tec-it.com/
mailto:office@tec-it.com


 
 
 

Page 54 of 58 

 

Barcode Studio User Manual  

Appendix A: Bar Codes 

A.1 Supported Bar Codes 

Please refer to the additional document “Barcode Reference” available from www.tec-it.com. 

This document contains an overview of the supported bar codes, enumeration values (for develop-
ers using TBarCode OCX), the standard print ratio and the standard check digit methods. 

A.1.1 MaxiCode 

12.1.1.1 Setting SCM parameters 

Please refer to the additional “Barcode Reference” available from www.tec-it.com. 

A.2 Check Digits 

The method for the check digit(s) calculation depends on the respective bar code type. A standard 
method for each bar code type is supplied. 

See section 7.8.2.2 for adjusting the check digit in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.3 Print Ratio 

The Print Ratio is the relationship between the widths of the bars and the widths of the gaps of a bar 
code. Each bar code symbology should be generated with certain print ratios only. 

See section 7.8.1.1 for adjusting the print ratio in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.4 Format 

Format is like a "mask”, which is used for formatting the bar code data before encoding (please do 
not mix up the Format with the Ratio Format). Placeholders in the specified format string can be 
mixed with constant data characters to build a final bar code data string. Also control characters are 
supported. 

See section 7.8.2.1 for adjusting the format string in Barcode Studio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

A.5 Escape Sequences 

If you want to encode non-printable or special characters in a bar code, “Escape Sequences” must 
be used. They always start with a backslash (“\”) followed by the sequence. They can be use for 
encoding binary data (Bytes) too (if the symbology you are using offers this feature – e.g. PDF417 
or Data Matrix). 

See section 7.8.2.3 for enabling or disabling the translation of escape sequences in Barcode Stu-
dio. 

For more information please refer to the “Barcode Reference” available at www.tec-it.com. 

http://www.tec-it.com/
http://www.tec-it.com/
http://www.tec-it.com/
http://www.tec-it.com/
http://www.tec-it.com/
http://www.tec-it.com/
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Appendix B: Error Messages 

Error Recommended Action 

Wrong character ‚xx„ at position yy! You entered a character which cannot be encoded with the selected 
bar code symbology. Please use different barcode symbology or 
change your input data. 

Wrong character 'xx' at position yy in the 
Format string! 

You entered a character to the format string which is no valid Format 
command and cannot be encoded with the selected bar code 
symbology. Please change or remove the invalid character from the 
Format string or use another symbology. 

Wrong check digit ‚xx„ at position yy! You entered a check digit which is incorrect for the selected bar code 
symbology. Please correct the check digit or remove it, so the 
application will calculate it automatically. 

Wrong number of input characters (needs xx 
chars)! 

You entered too many or too few characters for the selected barcode 
symbology. Please use another symbology or correct the length of the 
input data. 

Input string too long The input string is too long for Barcode Studio. Please reduce the 
length of the input data. 

No input characters No barcode data is specified. Please enter some data in the Barcode 
Data field. 

Not implemented (reserved for future use) The selected barcode symbology is not supported yet. Please contact 
TEC-IT for an implementation request. 

Error in linear Component: No input characters. You want to generate a composite symbology. The data for the linear 
symbol is missing. Please enter the data into the Barcode Data field. 

Error in linear Component: Wrong character „x‟ 
at position n! 

You want to generate a composite symbology. The data in the linear 
symbol is incorrect. Please correct the data in the Barcode Data field. 

Error in linear Component: Invalid number of in-
put characters in combination with composite! 

When using UCC/EAN-128 as part of a composite symbology you 
have to enter a minimum amount of symbol characters (which is not 
equal to the amount of input characters). Please increase the number 
of input characters in the Barcode Data field. 

Error in linear Component: Wrong number of 
input characters (needs xx characters).  

You want to generate a composite symbology. The number of 
characters for the linear component is wrong. Please correct the data 
in the Barcode Data field. 

Error in 2D Composite Component: No input 
characters. 

You want to generate a composite symbology. The data for the 2D 
symbol is missing. Please enter data into the Composite Data field. 

Error in 2D Composite Component: Wrong 
character „x‟ at position n! 

You want to generate a composite symbology. The data in the 2D 
symbol is incorrect. Please correct the data in the Composite Data 
field. 

Error in 2D Composite Component: Input string 
too long! 

You want to generate a composite symbology. The data in the 2D 
symbol is too long (e.g. more than 56 characters in CC-A). Please 
reduce the length of the composite data or choose another 2D 
composite type. 

Increase bar code size. Resolution too low! The output resolution is too small to produce a readable bar code with 
given symbol size. You either have to increase the width/height of the 
bar code, the module width, or the output resolution. 

Invalid code page or invalid characters! You entered characters which cannot be encoded in the selected code 
page. Please use a different code page or change the input data. 

Table 20: Error Descriptions 
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Appendix C: Image Types 

Choosing Export ► Export Barcode… the bar code can be converted to a bitmap or image format. 
The following image types are available. Please keep in mind that the bar code will become 
unreadable when producing a bitmap with very low resolution (does not apply for vector based 
image formats). 

Image 
Format 

Description Internal 
Format 

Color Printing 
Resolution 
included? 

BMP Microsoft Windows Bitmap. Bitmap b/w No 

EPS Encapsulated PostScript. 

Newer releases of Barcode Studio are exporting a vector EPS 
format. V4.x used a bitmap based format. 

Vector 
based 

color 
(RGB) 

No 

EPS EPS file which uses the CMYK color space (4 color channels) in-
stead of RGB. Drawing is in vector based format. 

Vector 
based 

color 
(CMYK) 

No 

EPS Grayscale EPS file which uses one channel (luminance) only. 
Drawing is vector based. 

Vector 
based 

b/w No 

GIF Graphics Interchange Format. Supported since Barcode Studio 
V7. Not supported in previous versions because of license terms.  

Bitmap color 
(RGB) 

No 

JPG Joint Photographic Expert Group image file format. Bitmap b/w Yes 

PDF Portable Data Format. Vector 
based 

color 
(RGB) 

No 

PNG Portable Network Graphics. Bitmap b/w No 

TIF Tagged Image File. No compression is used (compressed 
formats available on request). 

Bitmap b/w Yes 

Table 21: Image Data Formats 
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Appendix D: Command Line Parameters 

The program can also be started at the command line. It supports various parameters which allow 
the user to automate the bar code-generation process. 

D.1 Syntax 

1) BCStudio -d=<data> -out=<outputfile> [[-s=]<settingsfile>] [-h=<height>] [-w=<width> |  

            -m=<modulewidth>] [it=<imagetype>] [-r=<dpi>] [-o][-fs=<fileseparator>] 

            [-log=<logfile>] [-q] 

2) BCStudio -datafile=<datafile> -out=<outputfile> [[-s=]<settingsfile>] [-h=<height>]  

            [-w=<width> |-m=<modulewidth>] [it=<imagetype>] [-r=<dpi>] [-o]  

            [-fs=<fileseparator>] [-log=<logfile>] [-q] 

3) BCStudio -datalist=<datalistfile>  [-skipheader=<numlines>] -outlist=<outputlistfile> 

            [[-s=]<settingsfile>] [-h=<height>] [-w=<width> |-m=<modulewidth>]  

            [it=<imagetype>] [-r=<dpi>] [-fs=<fileseparator>] [-o] [-log=<logfile>] [-q] 

4) BCStudio <settingsfile> 

5) BCStudio -g [[-s=]<settingsfile>] 

6) BCStudio [-? | -help] 

-d=<data> Specifies the bar code data. Can be used alternatively to -datafile=<datafile> and  
-datalist=<datalistfile>. 

-datafile=<datafile> Specifies the bar code data through a data file. Can be used alternatively to -d=<data> 
and  
-datalist=<datalistfile>. 

-datalist=<datalistfile> Specifies the file that contains a list of data strings (separated line breaks). Can be used 
alternatively to -d=<data> and -datafile=<datafile>.If this argument is used you must also 
specify -outlist=<outputlistfile>. The number of entries in both lists should be equal. 

-skipheader=<numlines> Specifies the number of lines of the data list that should be handled as header lines and 
so skipped. This argument can only be used in conjunction with -datalist=<datalistfile>. 

-out=<outputfile> The name of the output file (image file). The filename extension may be one of the 
following: JPG, GIF, TIF, BMP, PNG, EPS, and PDF. The filename extension must be 
specified! Can be used alternatively to –outlist=<outputlistfile>. 

-outlist=<outputlistfile> The name of the file that contains a list of output file names (separated line breaks). Can 
be used alternatively to –out=<outputfile>. If this argument is used you must also specify  
-datalist=<datalistfile>. The number of entries in both lists should be equal. 

[-s=]<settingsfile> Settings-Files are *.bc files which have been created with Barcode Studio. By passing 
command line arguments you can override values of the settings file. 

If you pass only the settings file without an argument name and no other argument, the 
application is opened in graphics mode. 

-h=<height> Height of symbol, measured in 1/1000mm. 

-w=<width> 
-m=<modulewidth> 

Specify either the total width of the symbol or the module width (dimension X or narrow 
bar width); values are measured in 1/1000mm. 

E.g.: -w=50250 … bar code is 50.25 mm wide 

-it=<imagetype> The type of the output file. It may have the same values as the file name extensions but is 
supplemented by E1C (EPS grayscale) and E4C (EPS CMYK). 

-o Optimal resolution (adapt module width to pixel width) – recommended for low resolution 
devices. 

-r=<dpi> The resolution of the output file in dpi (default = 96 dpi). 

-fs=<fileseparator> A custom file separator that can be used for separating file names of command line 
arguments and for the list of file names in the output file names list. 

-log=<logfile> The name of the log file. If this argument is not set, no log file is generated. 

-q  Activates the “Quiet Mode”. The program does not interact with the user. This setting is 
useful, for instance, to run Barcode Studio on servers. 

If an error occurs, a message is logged to file error.log. 

-g Starts the application in "Graphics Mode". This setting is needed to pass a settings file to 
Barcode Studio and start it in graphics mode. 

-? 
-help 

Display the help screen. 
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D.2 Examples 

Generate Code128 (default), content=98765, size 50x30mm: 

bcstudio -d="98765" -out=barcode.bmp -w=50000 -h=30000 -o 

Generate a bar code image (JPG) with 300 dpi and 0.330 mm module width: 

bcstudio -d="12345" -out=barcode.jpg -h=30000 -m=330 -r=300 

Generate a bar code (symbology defined in bc file) 70x30mm: 

bcstudio -d="123" -out="c:\pictures\bc.jpg" -s=bcsettings.bc -w=70000 -h=30000 -o 

Generate a bar code with data from txt file: 

bcstudio -datafile=data.txt -out=barcode.tif -s=bcsettings.bc -w=70000 -h=30000 -o 

Generate a list of bar codes using the arguments datalist and outlist: 

bcstudio -datalist=datalist.txt -outlist=outputfilenames.txt -s=bcsettings.bc -o 

Generate a bar code with optimized readability and fixed module width: 

bcstudio -d="ABCDE" -out=barcode.bmp -s=bcsettings.bc -h=30000 -m=265 -o 

Open a settings file in graphics mode: 

bcstudio bcsettings.bc 

  or 

bcstudio –g -s=bcsettings.bc 

 


